Electronic Spreadsheet

Fastrack GEwsmN

» Spreadsheet Software: A Spreadsheet software is an application software that is used for doing tasks such as numerical
and statistical calculations, sclentific calculations, data interpretation, Financlal and accounting data analysis, budgeting and
much more. There are different spreadsheet software such as Lotus 1.2.3, Micrasoft Excel, Corel Quattro Pro, OpenOffice
programs such as Calc and much more.

> Features of a Spreadsheet Software: A spreadsheet software or a spreadsheet processor Is an application software that
Is used to organise and to analyse data In a tabular form.
» Spreadsheet software Is utllised For manipulation of data and creation of workbook Ffiles comprising one/more
related worksheets.
» |t has many In-built tools, such as formulas and Functions that help in manlpulating data.
» It allows you to analyse data in a quick and presentable manner with the help of charts and graphs.
» It has In-bullt Features, such as Autofill, that help In Filling In the serles of data, automatically.
» Calc: It Is the spreadsheet component of LibreOFFice. You can enter data (usually numaerical) In a spreadshecet and then
manlpulate this data to produce certain results, Alternatively, you can enter data and then use Calc In a ‘What if..." manner
by changlng some of the data and observing the results without having to retype the entire spreadsheet or sheet,

» Spreadsheets, Sheets and Cells: Calc works with documents called Spreadsheets. Spreadsheets conslst of a number of
Individual sheets, each sheet contalning cells arranged In rows and columns. A particular cell is identlfied by Its row number
and column letter. Cells hold the Individual elements « text, numbers, Formulas and so on -~ that make up the data to
display and manipulate. Eoch spreadsheet can have up to 10,000 sheets and each sheet can have a maximum of 1,048,576
rows and 1,024 columns.

» Calc Maln Window: When Calc Is started, the main window opens. The parts of this window are described belovs:
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» Title Bar: The Title bar, located at the top, shows the name of the current spreadsheet. When a spreadsheet Is newly
created from a template or a blank document, its name Is Untitled X, where X Is a number. When you save a spreadsheet
fFor the First time, you are prompted to enter a name of your choice.
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> Menu Bar: When you select an item on the Menu bar, a

sub-menu drops down to show commands.

» Flle: Contalns commands that apply to the entire
document; For example, Open, Save, Wlzards, Export
as PDF, Print, Digital Signatures.

» Edit: Contains commands for editing the document;
For example, Undo, Copy, Changes, Fill, Plug-in.

» View: Contains commands for modifying how the
Calc user Interface looks; for example, Toolbars,
Column & Row Headers, Full Screen, Zoom.

» Insert: Contains commands for inserting elements
into a spreadsheet; for example, Pictures, Frames,
Special Characters, Charts, Functions.

» Format: Contains commands for modifying the
layout of a spreadsheet; For example, Cells, Page,
Styles and Formatting, Allgnment.

> Sheet: Contains the most often used commands
for handling sheets, such as Insert and Delete Cells,
Columns, Rows and Sheats, as well as Comments
and Flll cells.

» Daota: Contalns commands for manipulating data
In the spreadsheet; For example, Define Database
Range, Sort, Statlstics, Pivot Tables and Consolidate.,

» Tools: Contains varlous Ffunctlons to help you
check and customise the spreadsheet; for example,
Spelling, Share Document, Gallery, Macros.

» Window: Contains commands For the display
window; For example, New Window, Split.

> Help: Contains links to the LibreOFFfice help system
and other miscellaneous Functions; for example,
Help, License Information and Check for Updates.

» Toolbars: The default setting when Calc opens is for the

Standard and Farmatting toolbars to be docked at the top
of the workspace.

Formula Bar: The Formula Bar Is located at the top of
the sheet in the Calc workspace. The Formula Bar s
permanently docked In this position and cannot be used
as a floating toolbar. If the Formula Bar Is not vislble, go to
View on the Menu bar and select Formula Bar. From left to
right, the Formula Bar consists of the following;

» Name Box: It glves the current active cell reference
using a combination of a letter and number, for
example, A1. The letter indlcates the column and
the number Indicates the row of the selected cell,

» Functlon Wizard: Opens a dlalog from which you
can search through a list of avallable functlons. This
can be very useful because it also shows how the
Functions are Formatted.

» Sum: Clicking on the Sum Icon totals the numbers
In the cells above the selected cell and then places
the total In the selected cell. IFthere are no numbers
above the selected cell, then the cells to the left are
totaled.

> Function: Clicking on the Function icon inserts an
equals (=) slgn Into the selected cell and the Input
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» Input Line: Displays the contents of the selected
cell (data, fFarmula, or function) and allows you to
edit the cell cantents. To turn the Input line into a
multiline input area for very long Formulas, click the
dropdown button on the right.

» Status Bar: The Calc status bar provides information

about the spreadsheet as well as quick and convenient
ways to change some of its Features. The status bar has a
quick way to do some math operatlons on selected cells In
the spreadsheet.

Sidebar: The Calc Sidebar (View > Sidebar) is located on
the right side of the window. It is a mixture of toolbar and
dialog. It is similar to the sidebar in Writer and consists
of five decks: Propertles, Styles and Formatting, Gallery,
Navigator and Functions. The decks are described below:

» Spreadsheet Layout

» Indlvidual Cells: The maln sectlon of the workspace
in Calc displays the cells in the form of a grid. Each
cell Is formed by the intersection of one column
and one row in the spreadsheet, At the top of the
columns and the left end of the rows are a serles of
header boxes containing letters and numbers,

» The column headers use an alpha character starting
at A and go on to the right. The row headers use a
numerlcal character starting at 1 and go down. These
column and row headers Form the cell references that
appear in the Neme Box on the Formula Bar. IF the
headers are not visible on the spreadsheet, go to View
on the Menu bar and select Column 8 Row Headers.

» Sheet Tabs: In Calc, you can have more than one
sheet in a spreadsheet. At the bottom of the grid of
cells in a spreadsheet are sheet tabs indicating how
many sheets there are in the spreadsheet. Clicking
an a tab enables access to each Individual sheet and
displays that sheet.

» Stoarting New Documents: You can start a new, blank

document in LibreOFfFice in several ways.

» Use File > New on the Menu bar and select the type
of document From the context maenu.

» Use the keyboard shortcut Ctrl+N to create a new
document. The type of document created depends
on which LibreOffice component Is open and actlve,
For example, if Calc Is open and acltlve, a new
spreadsheet is created,

» Use File > Wlzards on the Menu bar and select the
type of document from the context menu.

» |If a document is already open in LibreOffice, click
the New Icon on the Standard toolbar and a new
document of the same type is created In a new
window.

» Opening Existing Documents: You can also open an

exlsting document In one of the following ways:

» When no document is open, click Open File or
Remote Flles In the Start Center to reach the Open
dialog.

» (o to File > Open or File > Open Remote Flle... on
the Menu bar the reach the Open dialog.

» Use the keyboard shortcut Ctrl+O to reach the
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» |IF a document Is already open, click the Open icon
on the Standard toolbar and select from a list of
avallable documents from the Open dlalog.

» Click the small triangle to the right of the Open
lcon and select from a list of recently opened
documents.

» When no document is open, double-click on a
thumbnail of recently opened documents displayed
in the Start Center. You can scroll up or down in the
Start Center to locate a recently opened document.

» Saving Documents: You can save documents as Follows:

» Save Command: Use if you are keeplng the
document, Its current Filename and locatlon.

> Save to Remote Server: Use If your document Is
already stared In a remote server or will be stored
In & remote servar,

» Save As: Use if you want to create a new document,
or change the filename and/or file Format, or save
the File in a different location on your computer.

» Save a Copy: Use if you want to save a copy of
your current document and keep it open for more
editing.

» Save All: Use to save all the open files open In your
current sesslon.,

» Save Command: To save o document IF you are keeping

the document’y currant Fllename and locatlon, do one of
the Following:

» Use the keyboard shortcut Ctri+S.

» Go to File > Save, File > Save to Remote Servar,
File > Save a Copy, or File > Save All on the Menu
bar.

» Click the Save Icon on the Standard toolbar.

Save As Command: To save a document IF you want to
create a new document, or change the filename and/or
File Format, or save the file in a different location on your
computer:

» Use the keyboard shortcut Ctri+ShiFt+S.
» Goto File » Save As on the Menu bar.

Editing A Worksheet: When a new warkbook Is opened,
the cells are set to a default slze, But sometimes, you may
want to modIfy the cell size, to add or delete more cells,
rows, columns, etc. Let us learn how to edit a worksheat.

» Editing Cell Contents: Sometimes, after entering
text In the cell, we need Lo edit the text. Far this, we
can perform the Following two optlons:

¢ Replacing the Text: To replace the text of the
cell, we need to click on the cell and make It
active. Then, we can type the new text from the
keyboard to replace the old ane.

* Modifying the Text: If we have typed incorrect
spellings or made any other error, in the content
of the text, we can modify it. We can do this by
using any of the following ways:

(@) Click on the cell to make It active, Then,
click on the formula bar and modify the
text.

(b) Make the cell active and then press the F2

key. Now edit the text.
frY Dnnhle-rlick an Fhe rall and edit Fhe Fext

» Formatting Data Iin a Worksheet: Data can be organised

into a general format in a worksheet by formatting it.
When you want to draw attentlon to some specific data
or want to make your worksheet visually appealing, you
should opt for Formatting the data in a worksheet. For
example, If you want to highlight the column headers
of the worksheet, or want to change the colour of some
specific cells to draw attention, you can do this by using
different Formatting options avallable In calc, to Format
data such as text, number and date. Let us learn those
Formatting optlons in detall here.
Formatting Font: The optlons For Farmatting the font are
found under the Tools -> Options-> Fonts.
We use the given options to work with the font of the
data. We can perform the following operations using the
Font Group:

» Changing font

» Changing font size

» Changlng font colour

» Changlng text style
Creating Serles/Autofill: Pattern-based data Is recognised
by calc Instantaneously and can be used to Ffill-up data
automatically. The calc Autofill Feature can be used to
populate a range of cells with elther a repeated value or a
sarles of numaerlc values, For example, number series, dates,
days of the week, months In a year and much more.

» Autofill Dates and Times: As dates and times are stored

in calc as numbers, these can also be used with the Autofill,
By default, IF we just type in a single date or time and
drag the Fill handle, dates and times will get completed
in @ sarles, by adding one day (Far dates), or ane hour (for
time). However, for dates, there are addltional Autofill
optlons. Apart From the four optlons for simple numbers,
there are some more optlons as follows:

» Fill Days: Look for a pattern In the day when Filling
the selected cells.

» Fill Weekdays: Look For a pattern in the day
when Filllng the selected cells, but do not Include
Saturdays or Sundays In the serles.

» Fill Months: Look for a pattern in the month when
Filing the selected cells.

» Fill Years: Look for a pattern in the year whan filling
the selected cells.

Formulas in Calc: Formulas are used to carry out
calculations that involve baslc arithmetlc operations such
as addition, multiplication, subtraction and divislon in calc,
You must have used Farmulas in mathematics, but in calc,
formulas are written in a different manner.

» Calc Provides Following Types of Formulas:

» Simple Formula: A simple formula [s an expression
that is made up of numbers, arithmetic operators,
cell addresses and parentheses.

e Components of a Formula: The following are
the components that make up a basic Excel
Formula,

e Oporators: They are speclal characters like +,
-, ><,/.", ", % that specify the arlthmetic
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¢ Cell References: These are the cell addresses or
the cell ranges that contain the values to be used
in calculations, For example, A3, B2, A2:A6.

o Constants: They are the fixed numeric or string
values, for example, 56,789 (numeric), “Hello”,
“Welcome"” (string) that are used in calculations.

* Functions: They are the in-built formulas whose
meaning and purpose are already defined in Calc
2010, For example, Sum, Max, Min, Sub and many
more,

e Equal to (=) Symbol: It i3 used to start an Calc
Formula.

o Parentheses: They are used to enclose cell
ranges, for example, Sum (C1:C4).

» Compoundor Complex Formula: Compound Formula,
also known as Complex Formula contains more than
one operator. A formula to calculate simple interest
like (Principal amount ¥ Rate of interest * Time)/100 IS
an exomple of a compound Formula.

> Text Formulas: Text formulas are used to add
characters and string values, Jolnlng of strings Ig
known as Concatenatlon. Strings can be added using

& symbol, Perform the below mentioned steps to

Joln twro strings:

e Step 1: Type two strings 'l Love’' and "My Country’
in cells A1 and B1, respectively.

o Step 2: Now for adding these two, write the
Formula eA18" "8B1 in the cell C1 and press the
Entar kay.

o Step 3: 'l Love My Country’ will be displayed In
the cell C1.

» Cell Reference: Cell Address, in a Formula, Is known as Cell
Reference. Cell Reference Is used For Identifying a cell or a
range of cells, In a worksheet, References help to look for
the values which are to be used in a fFormula In different
parts of a worksheet,

> Types of Cell References: There are three different types
of cell references, in calc

>

Relative Cell Reference: It is based on the relative
position of the cell contained In the formula. A
spreadsheet cell reference, by default, Is known as
relatlve. When a formula Is copled and pasted to
other cells, the cell reference in the Formula or the
Function changes relatively to the location where it
is copled. For example, if a formula =SUM(C3:G3) is
written In the cell H3 and s copled to H4, then the
Formula will automatically change to aSUM(C4:G4)
For the cell H4.

Absolute Cell Reference: When the cell address |s
not changed In a formula, while copying It to other
cells, It Is known as absolute cell reference. You can
add a dollar sign (S) in front of a row address and
column address to make the absolute cell reference
of a cell, If a cell contains a value that needs to
remaln fixed in a formula, we should specify the
cell reference of that cell as absolute cell reference.
SHS2, SAS4 are some examples of absolute cell
references.

Mixed Cell Reference: It s a comblnation of both,
l.e, absolute and relative cell references. A mixed
cell reference I8 elther an absolute row and a
relatlve column or an absolute column and a relative
row. We add the $ sign befare the column name
to create an absolute column or before the row
number to create an absolute row.

» Functions: A Function Is a pre-defined Formula that
performs calculatlons using specific values in a particular
order, Functions can be used to carry out simple as well as
complex calculations. Functions save time as one does not
need to write the formula. Also, writing down Formulas
For dolng calculations can be tedlous and complicated at

times.

> Some Commonly Used Functlons: There are many pre-defined functions in calc which we can usa. The Following table Usts
some commonly used Functions In calc, along with thelr purpose and examples.

Function Name Purpose Example
SUM(range) It calculates the sum of a glven range, =SUM(A4:B6)
AVERAGE(range) It calculates the average of a glven range. =AVERAGE(A4:B6)
COUNT(range) It counts the number of cells In range. =COUNT(A4:B6)
TODAY() It displays the current date. =TODAY()
INT(number) It rounds off a number to the nearest Integer. =INTEGER(102.78) or

m|NTEGER(C5)
ODD(number) It returns a number rounded up to the nearest odd Integer. | =0DD(102.78) or
=0DD(CS)
ROUND(number, num_digits) | It rounds off 3 number to specified digits. =ROUND(234.567,1) or
=ROUND(CS)
SQRT(number) It returns a square root. =SQRT(16) OR
=SQRT(CS)

> Autosum Feature: The AutoSum feature In calc Is used to automatically add the values, glven In the selected cells. A
range of cells can easily be added using the AutoSum option on the Formulas tab. AutoSum recognises the data that
Is consecutively entered and when it sees an empty cell, thse AutoSum stops. We can also use the AutoSum feature to

perform other calculations, such as AVERAGE, COUNT, MAX and MIN.
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» Embadding Charts in a Worksheet: A chart Is a graphlcal

Ctrl + F1 Show comment
representation of data entered In a worksheet that makes 5 B s
it easier for a user to comprehend data. Charts help you to Ater edit moae |
analyse and compare the data, instantly. Click the Insert Ctrl + F2 Open Function wizard
Chart lcon on the Standard toolbar. Shift + Ctrl + F2 | Move cursor to Input Lne
» Keyboard Shortcuts: Cerl + F3 Open Define names
Cirl + Hame avactrens tak) Shift « Ctrl + F4 | Show/hide Database explorer
Ctrl + End Move cursar to last cell with data - Bt - M
Inside F5 Show/hide Navigator
Home Maove cursor to first cell of the row Shift + F5 Traces dependents
End Maove cursar to last cell of the row Shift + Ctrl + F5 | Mowves cursor to Sheet area
Shift + Home Select from current cell to frst cell F7 Check spelling
of the row Shift + F7 Traces precedents
Shift + End Select from current cell to last cell of Ctrl + F7 Opens Thesaurus

the row F8
Select from the current cell up a page

Enable/dlsable additlonal gelection

Shift + Page up mode

Shift + Page Select from the current cell down a Ctrl + FB Highlight cells containing values
down page F9 Recalculate formulas in current sheet
Ctrl + 1 Open Farmat cells Ctrl + F9 Update chart

Ctrl + Shift « 1 | Two decimal places Ctrl + Shift + F9 | Recalculate formulas In all sheets
Ctrl + Shift + 2 | Exponentlal format F11 Open Styles

Ctrl + Shift + 3 | Date format Shift + F1 Create a document template

Ctrl + Shift + 4
Ctrl + Shift + &
Ctrl + Shift + 6

Shift + Ctrl + F11| Update the template
Group the selected data range
Ungroup the selected data ranpe

Currency format
Percentage format F12

Standard format Ctrl + F12

Practice Exercise

Q 6. Method to open LibraOffice Calc In Windows Is:
a. double-click the shortcut of LibreOffice Calc on

2| Multiple
N Choice Questions

desktop
Q1. Which of the following help us to perform varlous b.click the window menu. select LibreOffice
calculations? appUcation, then click LibreOffice Calc
a. Writer b. Spreadsheet c. Botha. and b.
¢. Impress d. None of these d. None of the above
Q 2. Spreadsheet is used for: Q7 Quick Access Tool bar Icon Is present on
a. managing financlol and accounting documents s
b. creating data reports a. Menu bar b. Standard Tool bar
c. Title bar d. Status bar

c. data analysls

d. All of the above Q 8. Default name of spreadsheet open In LibreOffice
Q 3. Spreadsheet packages also provide built-in Cale IS i, .
___________________________ formulae. a. untitled X, where X Is a number
a. Mathematlcal b. Statistical b. calc X. where X Is a number
c. Both a. and b. d. None of these C. spreadsheet X, where X Is a number
Q4. Which of the following is not a Spreadsheet d. None of the above
Software? Q9. In LibreOffice Calc Scroll bar is present on
a. Microsoft Excel b. LibreOffice Calc EREIRIPT RIS 1, || [—mm——— | 1[5 ] 7 ()
c. OpenOffice Calc d. None of these a. left, right b. right. top
B Wit Operating System, the LibreOffice C. bottom, right d. top, bottom
gets installed by default. Q 10. By default.................e.......... Sheets is/are present in

a. Windows b. Unux (Ubuntu) LibreOffice Calc Spreadsheet.
c. Both a. and b. d. None of these a. 1 b. 2 c. 3 d 4
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Q 1.

Ql2.

Q3.
Ql4.
QI5.
Ql6.

Q17.

Q 18.

Q19.

Q 20.
Qal.

Q2z.

Q 23.

Q 24.

Q 25.

Q 26.
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In are in

LibreOffice Calc, Row headings
a. numbers b. alphabets

c. alphanumeric d. None of these
........................... contalns the menus with commands
for various tasks.

a. Status bar b. Standard Toolbar

¢. Formatting Toolbar  d. Menu bar
cecerssrsnenncennenennes 18 lOCAted just below the Title bar.
a. Standard Toolbar b. Menu bar

c. Formatting Toolbar  d. None of these
........................... Is the shortcut to exit LibreOffice.
a.Ctrl +Q b. Ctrl + E

c. Ctrl + X d. None of these

Cut, Copy, Paste options are available in
........................... menu

a. Flle h. Edit c. Format d. View
Insert Cells, Insert Rows, Insert Columns options are
CAFE 115215 P2 i |  [1AUS—— menu.

a. File b. Insert  c. Sheet d. Data
Placing the mouse cursor over any icon displays a
small box called ....... e ..... which gives a brief
explanation of the Icon.

a. Toolbar b. Toolbox

c. Tooltip d. All of these
........................... shows the address of Active Cell.

a. Name Box b. Current Cell

c. Formula bar d. None of these

The Worksheet in Calc is also referred to as

llllllllllllllllllllllllllll

a. Warkbook b. Spreadsheet

c. Sheet d. None of these
Columns are ....ceeevvrrssnnenssanns in the table.
a. harlzontal b. vertical

c. dlagonal d. None of these

Column Heading of 27th Column in Calc sheet Is

llllllllllllllllllllllllllll

X d. ZA

The intersection of a row and column is called
a. Cell Address b. Cell

. Point of Intersection  d. None of these

Which of the following Is invalld Cell Address?

a. Al b. 2247

c. 91A d. None of these

Which of the following is not true about Currently
Selected Cell?

a. Currently Selected cell Is called Active cell

b. Currently Selected Cell's Address Is visible In Name
box

c. Currently Selected Cell have thick border

d. Nane of the above

Address of cell formed by intersection of tenth
column and nineteenth row is ........cuuunns

d. 19J

a. K19 b. 19K .19

Cell address of first row and first column
a. Al b. 1A

c. A-1 d. None of the abave

Q27.

Q 28.

Q 29.

Q 30.

Q3L

Q 32.

Q 33.

Q 34,

Q 35.

il

Which key combination moves the active cell
(Selected Cell) to the end of the data range In a
particular direction?

a. Ctrl + Home b. Ctrl + End

c. Ctrl + Arrow keys d. None of these

Which key combination moves the active cell
(Selected Cell) to Al cell?

a. Ctrl + Home b. Ctrl + End

c. Ctrl + Arrow keys d. Nane of these

Which key / key combination moves the worksheet
one screen up?

a. Ctrl + Up Arrow Key  b. Ctrl + Page Up

c. Page Up d. None of these

A block of adjacent cells In a worksheet which Is
highlighted or selected Is called ........occciinniinnanan :

a. Block of cells b. Range of cells

¢. Both a. and b. d. None of these

In LibreOffice Calc, .....ccoomirivicerinnnss 1S 3Ny text
entered by using a keyboard.

a. Values b. Poster

C. Label d. None of these

By default labels are .......cccccernuvinvienins allgned.

a. left b. right

d. None of these
only numbers are called

c. tap
The data conslisting of

FrRERGGRSEER BRI RGN RET W

a. Labels b. Values

c. Functlons d. None of these

By default Values are .....c..cuvnnviinnnnennn aligned.
a. top D, right

c left d. None of these

Any expressions that begins with an equals '=' |s
LEEAROT A5 o cnnsminissisinsis

a. function b, formula

c. both a. and b. d. None aof these

Fill in the Blanks

N Type Questions

Q 36. The column immediately next to column “Z° Is

AEEEE RN A R AR E PR RN &

Q 37. The default extension of a workbook created using

Q 38.

a LibreOffice Calc spreadsheet Is........ccceeiinvvnnriinees :

The spreadsheet feature used to continue the
series is called as ....ccvvvverrnnisiensens ‘

Q 39. The formula "=MIN(C1:C5)" stored In cell C6 when

Q 40.

Q 4l

Q 4a2.

copled to cell D6 changes to .......c.cvvvviinininens .

The formula in cell A2 is =B2+C3. On copying
this formula to cell C2, C2 will change to

The cell address of the cell formed by the
intersection of the ninth column and the eighth
row will be ....ccoeeviviirerncnnnne.

$A19B2 is an example of
referencing in spreadsheet software.
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2] Assertion and Reason ]
NType Questions 38. Fill Handle

Directions (Q. Nos. 43-47): In the questions given 39. =MIN(D1:D5)

below, there are two statements marked as Assertion 40. =D2 + E3

(A) and Reason (R). Read the statements and choose the 41. 18

correct option. 42. mixed

a. Both Assertlon (A) and Reason (R) are true and 43. (d) 44. (b) 45.(c) 46.(b) 47.(d)
Reason (R) Is the correct explanation of Assertion (A).

b. Both Assertion (A) and Reason (R) are true. but ?] Case Studg Based
Reason (R) Is not carrect explanation of Assertion (A). e —

c. Assertlon (A) Is true, but Reason (R) Is false.

d. Assertion (A) Is false, but Reason (R) Is true. Case Stl.ldv 1

Q 43. Assertion (A):

A spreadsheet software or a

spreadsheet processor is a system software that |s
used to organise and to analyse data in a tabular
form.

Reason (R): Spreadsheet software is utilised for
manipulation of data and creation of workbook
files comprising one/more related worksheets.

Q 44, Assertion (A): Aworksheet is the actual area whare :
you work in calc. It is like a page in a notebook, cell (maximum value) of the range, Eventually
where we write and note down our Information. SEI? umm; cells cun beh udde«_ﬂ 1o this; seiection,
Ruason: (1) A workbuskdactunily Hke's notebook then the range 18 cu]]r.,dr an irregular cell runge.
that has multiple pages with cells in it. It contains LTU uﬂf muij_gﬂhiii[{u {;2; :1;; [;tnlun; jftfxgrrimn HE;;“”,:
three worksheets by default, but mare worksheets mathematical range, in which it is a collection
can be added depending upon the requirement. of values between a maximum and a minimum
Q 45. Assertion (A): The Quick Access toolbar contalns value,
the commands that are frequently used such as When entering a range of cell references as an
Save, Undo and Redo. argument for a function or when creating a churt,
Reason (R): The Name box displays the cell address in addition to typing in the range manually, the
of an active cell. A cell address is made up of row runge can ulso be selected using pointing. Ranges
number and column number such as C7, DB, etc. are identified h}’ the cell references or addresses
Q 46. Assertion (A): Cell Is the area which accepts a value of the cells in the upper left and lower right
such as number, text or formula. The intersection corners of the range. These two references are
Gllia e e S e calE sepnm{e,d by a colon. The colon tells spreadsheet
Reason (R): The Status bar displays the sheet to lﬂC!ﬂd{t all the cells between these start and
information as well as the insertion point location. i g,
From left to right, this bar contains the total Q1. Range of cell C2 : C7 Includes .......cccuinmrecancrsannns
number of pages and words in the document and EGHIS
other Information such as language used, etc. = ﬁll 5 @ 0 E k.
Q 47. Assertion (A): The optlons for formatting the font i el s
are found under the Font group on the Insert tab. o AL FaTE
Reason (R): The Insert worksheet button on the ki
sheet tab is used to insert a new worksheet in the SR ERTL Leitimn rangs
wothbtok. d. None of the above
Q3. Cell Range A1:D3 consist of ....ciiveiinmnscsinnnna
v Answers 5 cells.

a. 3 b. 4 . 12 d. 10
1L(b) 2.(d) 3.(c0 4.(d) 5.(b) 6. () 1 . — . key is used to select more
7.(c) 8.(a) 9.(c) 10.(a) 11.(3) 12.(d) than one range uf cells' In a worksheet.

13.(b) 14.(2) 15.(b) 16.() 17.(c) 18.(a) 3 iﬂ" E i“'“ -
C. . None of these
Weie 20 (b)) 2Lla) (22:b) 28.00) Fm Q5. What Is the address of the first cell represented
25.(c) 26.(a) 27.(c) 28.(a) 29.(c) 30.(b) by Range D34 : F40?
31.(c) 32.(a) 33.(b) 34.(b) 35.(b) a. Fa0 b. D34 c. D40 d. F34
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A cell range in a spreadsheet file is a collection of
selected cells, This range 18 usually symmetrical
(square), but can exist of separate cells just the
same. A cell range can be referred to in a formula
as well.

[n a spreadsheet, a cell range is defined by the
reference of the upper left cell (minimum value)
of the range and the reference of the lower right
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work had to be done using pencil and could only
be penned when one was sure that the data is not
going to change. The introduction of spreadsheet
on compulers revolutionised the world of
number juggling. It allowed user (o quickly enter
data electronically and edit it as required. Even
complicated calculations could be performed and
the data could be presented in the form of graphs
and charts for easier comparison of two sets of
data.

Q1. On aspreadsheet the active cell is indicated by:

e Answers »

1. (c) 2.(b) 3.(¢) 4. (b) 5. (b)

Case Study 2

Operators in Spreadsheet specifies the type of
calculation to be performed on a given set of
values. Obviously not restricted (0 numeric
values only, we can use operators over different
data types other than numeric (for example,
Text/Character data type). Spreadsheet has a

rich variety of operators to perform calculative a. a dotted border b. a dark wide border
aclions on a given set of data. c. a blinking barder d. by Italic text

Arithmetic Operators are used for arithmetic Q2. Which of the following keyboard shortcut can
be used for inserting comment?

a. Ctri+Alt+C b. Shift+Alt+C
c. Ctri+Shift+C d. Ctri+Alt+5

operations like addition, subtraction,
multiplication, division, etc. Arithmetic operators
follow the order precedence. Exponential and

Percentage operators have the highest precedence Q3. Which key Is used For help in Ms Excel?

and then Multiplication and Division followed by a. F2 b. F1

Addition and Subtraction. Logical or Compurison c. F3 d. None of These
Operators are used in Spreadsheet o logically Q4. Which shortcut key is used to insert cell in
compare the two values (numeric or text). LibreOffice Calc?

Q1 LibreOffice Calc USES ..ccvnmniinmsensissiiananns oparator a. Ctrl + b. Ctrl ¢+ c. Shift ¢+ d. Shift +
for division. Q5. Which of the following is not a valld zoom
0./l b. \ percentage In Excel?

G d. None of these a. 10 b.4a00 c 100 d. 300

Q2. Which of the following symbol is used for A
exponentiation (power) in LibreOffice Calc? " nswers .
a. " b./®

1 2. 3. (b 4, (b .
.~ d. None of these ) ) (o) ) @

Q 3. Evaluate the following formula: Case Study 4
=(5°4)"2 LibreOffice Calc is the sprendsheet component of
a. 40 b. 80 the LibreOffice software package. After forking
c. 400 d. None of these from OpenOffice.org in 2010, LibreOffice

04. Evaluat@ th@ fuuuwing furmuln: CHJC UHE!CFWCH{ cd ﬂlﬂSSiVE TC-WDI‘]( Df DK[CI‘TIIII

@ 16/(4°2) reference handling to fix many defects in formula
calculations involving external references and to
a. 0 b. 1 c. 16 d. B : ; ;
_ boost data caching performance, especially when
Q5. E\;ﬂl;lﬂ;ﬂ;hﬂ following formula: referencing large data ranges.
ml+2"2-
Calc is the spreadsheet component of LibreOffice.
3. 1 b. 2 & 3 d. 4 . .
Spreadsheets allow us (o organise, analyse
° Answers 2 and store data in tabular form. Furthermore in

a spreadsheet we can manipulate this data to
produce certain results, Other features provided
by Calc include:

Case Study 3 » Functions, which can be used o create
formulas to perform complex calculations on
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Spreadsheet as the name suggests is one big
table or chart with data spread all over the page.
Befare the advent of computer programs, paper
spreadsheets were used to record data for financial
analysis. The accountant had to spend several
hours recording data in tiny rows and columns
and calculating results using a calculator. All the

data.

* Database functions to arrunge, storc and filter
data.

* Dynamic charts giving a wide range of 2D and
3D charts.

 Ability to open, edit and save Microsoft Excel
spreadsheets.
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Q L Cell Al contains the number 10 and B1 contains 5.

Q2.

Q3.

Q4.

Qs.

What will be the contents of cell C1, if the formula
=A1+B1°2”3 is entered in cell C1?

The contents of Cell A1, B1,C1 and D1 are 5,-25,
30 and =35, respectively. What will be the value
displayed in cell E1 which contains the formula
=MIN(A1:D1).

Cell D5 contains the formula =$B$5+C5 and this
formula is copled to cell E5, what will be the copled
formula in cell E5?

Cell D5 contains the formula =$B5 + C5 and this
formula is copled to cell E5, what will be the copled
formula in cell E57

Cell D5 contains the formula =$B5 + C$5 and this
formula is copied to cell E6, what will be the copled
formula in cell E67

Answers o

Answers s

Cell Reference Is used for Identifying a cell or a
range of cells, in a worksheet. References help to
look for the values which are to be used in a formula
in different parts of a worksheet.
There are three different types of cell references:

(i) Relative cell reference

(i) Absolute cell reference

(iii) Mixed cell reference
If a formula =SUM(C3:G3) ls written In the cell H3 and
Is copled to H4. then the formula will automatically
change to =SUM(C4:G4) for the cell H4.
When the cell address is not changed in a formula.
while copying it to other cells. It i known ag absolute
cell reference.
Mixed cell reference Is a comblination of both, le.
absolute and relative cell references. A mixed cell
reference is either an absolute row and a relative
column or an absolute column and a relative row.

1. 50
5 .35 ? | Very Short Answer
3, =5B55+¢D5 N Type Questions
4. =585+ D5 QL What do you mean by Spreadsheet/Electronic
5. aSB5 + DS5 Spreadsheet?
Ans. A spreadsheet is a grid which Interactively monages
Case Study 5 and organises data In rows and columns, It Is also
Cell Reference: A cell reference in cale refers (o Called a5 E{EC“'D_”IE SpRRAtIENATL,
the value of a different cell or cell range on the Q2. In which operating system LibreOffice installed by
; - default?
current worksheet or a different worksheet within
Ans. Linux(Ubuntu)
the spreadshect. A cell reference can be used us o
: : . Q 3. Name any three components of LibreOffice.
variable in a formula. The simplest cell reference
: . Ans. Three components of LibreOffice are;
appears as o simple mention of the referred cell () LibreOffice Calc
after an equal sign. For example (=C5) refers to () UbreOffice Writer
the value within cell C5. It means that the value (i) LibreOffice Impress
of the current cell is equal to the value of C5.The Q 4. How to start the LibreOffice Calc In Windows?
notation (=A1:C6) refers to cell range Al through Ans. Steps to start the LibreOffice Calc In Windows are:
C6. Independently it doesn't mean anything and Double-click the shortcut of LibreOffice on the
cale will return standard error # VALUE! You can Desktop.
find more information about standard calc errors OR
in our calc Guideline for Professionals: Don't Click the window menu. select LibreOffice
Neglect calc Errors! But when the reference to applcation, then click LibreOffice Calc.
a range is used in a function, the magic happens. Q5. How to start the LibreOffice Calc in Linux?
For example =SUM(A1:C6) will return the Ans. In Ubuntu Linux. find the Calc Ilcon on application
total value of the cell range Al through C6 and launcher or ‘search It b"!’r clicking on “Show
mAVERAGE(A1:C6) returns the average of this Application™and the cick on iean.
cell range. Q 6. What Is a chart?
Ans. A chartls a graphical representation of data entered
QL Define Cell Referance. In a worksheet that makes It easler for a user to
Q2. Name all the types of cell references. comprehend the data. Charts help you to analyse
Q 3. Give an example of Relative cell reference. and compare the data. instantly.
Q 4. What do you mean by Absolute cell reference? Q7. Define the term workbook.
Q 5. Define Mixed cell reference. Ans. A workbook Is a collection of worksheets,
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Q8.

Ans.,

Q9.

Ans.

Q 10.
Ans.

Q 11

Ans,
Q12
Ans.

Q13.

Ans,
Q 14,
Ans,

Q 15.

Ans.
Q 16.

Ans,
Q17.
Ans,

Q 18.
Ans.

Q19.

Ans.
Q 20.
Ans.

Q2L
Ans.
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Reena is new to Calc. Her instructor has asked
her to open Calc on her PC and questioned about
active cell. Help Reena in identifying the active cell
on her screen,

An active cell is a cell with heavy black colour
boundary.

What is the default alignment of number, text and
formula in a spreadsheet?

Default alignment of text or label entry is left
alignment and for numbers and formula it is right
allgnment.

Elaborate the formatting necessary.

With formatting, we can make some data to be
bolder, rotated or In different colour. So, baslcally

formatting provides worksheet a neater and more
leglble outloale

Soham has clicked on the cell residing at the
intersection of first row and ninth column. What
will be the address of the selected cell?

First row and ninth column addrese will be Il.

In Calc, how many ways are there to express/
format a number?

Numbers In Calc can be expressed In many different
formats like date, time, percentage or decimals.

Name the toolbar of spreadsheet which has all the
options of changing the font properties.

Formatting Toolbar
What do you mean by relative referencing?

Cell referencing in which the cells are referred by
thelr relative position In the worksheet relative to a
particular cell is called relative referencing,

The cell A1 has value Monday, If you are asked to
click and drag the Fill handle of A1 downslde then
what will be the contents of cellA2,A3,A4 and AS?

Cells A2, A3, A4 and A5 will contain Tuesday,
Wednesday, Thursday and Friday respectively.

If = 6 -5 °2 Is entered In a cell, then what will be
the cell content?

-4 viill be contained in cell as a result.

What do you mean by Tooltip?

When we place the mouse cursar over any lcon, It
displays a small box called a tooltip. It gives a brief
explanation of the Icon functlon.

What do you mean by Worksheet in Calc?

The worksheet In Calc is also referred to as
spreadsheet. Each sheet can have many Individual
cells arranged In rows and columns.

Name the baslc element or bullding block of
spreadsheet.

Cell

What do you mean by Cell?

The Intersection of a row and column Is called a cell
What do you mean by Active Cell?

The selected cell is called Active Cell It Is always
highlighted. with a thick border. The address of the
active cell is displayed in the name box

Q 22.

Ans.
Q 23.
Ans.
Q 24.

Ans.
Q 25.

Ans.

Q 26.

Ans.
Q 27.

Ans.
Q 26.

Ans.
Q 29.

Ans,
Q 30.
Ans.

QL

Ans.
Q 32.

Ans.

Q 33.
Ans.

Q 34,
Ans.
Q 35.
Ans.

Name the bar which is located at the top of the
LibreOffice Calc window.

Title bar
Define Title bar.
Title bar shows the name of the current spreadsheet.

What is the default name of the first file opened In
LibreOffice Calc?

Untitled 1
Write the cell address of the following:

(i) Seventh column and tenth row.......
(if) Tenth column and nineteenth row........

() GIO

(i) N9

Write the cell address LK89 is situated in row
numbet......... and column letter ........ :

B9 and LK

Write the shortcut to move the cell to the end of

the data range in a particular direction.

Ctrl + Arrow Keys

Write the shortcut to move the cell pointer to Al
position.

Ctrl + Home

Write the shortcut to move the cell pointer to
bottom right cell of the data range.

Ctrl + End
What do you mean by Range of cells?

A block of ad|acent cells In a worksheet which Is
highlighted or selected Is called a range of cells. For
example, A1:C3.

Identify the range of cells as Row range, Column
range, Row and Column range, C9 :J9

C9:J9 -~~~ - Row Range

Name the two types of data that can be entered
in a cell.

Two types of data that can be entered in a cell are:
(I) Label (I Values
(i) Formulag
What do you mean by Formula in Calc?

Any expressions that begins with an equals to sign
(‘=') is treated as formula. For example =A1 + B1

Evaluate the expression = (5°4)"2
400
Define Label

If we forgot to put the ‘=" before the farmula, it veill
be treated as a Label

2| Short Answer

\ngpe Questions

QL

Ans.

Write three uses of spreadsheet.
Spreadsheet is used for:
(I) Managing financlal and accounting documents.
(i) Creating data reports. generating invoices.
(i} Data analysis from sclentific and statlistical
researches.
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Q 2. Listanyfour activities which can be done accurately
or efficlently on LibreOffice Calc.
Ans. Four activities are:
(I) Flleering the required data.
(if) Calculations using formula and functions.
(i) Check the valldity of data.
)

(lv) Arranging data In ascending and descending
order.

Q 3. Write any four Spreadsheet software.

Ans. Four Spreadsheet software are:
() Microsoft Excel
(I} LibreOffice Calc
(i) OpenOffice Calc
(lv) Apple Inc. Numbers
Q4. Name any eight parts of User interface of
LibreOffice Calc.

Ang. Elght parts of User Interface of Libre Office Calc are:

(I) Quick Access Tool bar  (ll) Title bar
(ill) Ribbon (iv) Control Buttons
(v) Name Box (vl) Formula bar
(vil) Formatting Tool bar  (vill) Zoom Control
(Ix) Column Headlng (x) Row Headlng.
Q 5. Name any four items/options available on Menu
bar.

Ans. Four items/options avallable on Menu bar are

(write any four)

(I) File () View
(1) Edit (lv) Format
(v) Insert (vi) Styles

Q 6. Name and explain in brief any two toolbars which
provide a wide range of common commands and
functions in LibreOffice Calc.

Ans. Two toolbars are:

(I) Standard Toolbar: The standard toolbar shows
the lcons far most common aperations, such as
editing. arranging, filtering. etc.

() Formatting Toolbar; It includes buttons for
font selection, size of text, allgnment cell value
formatting and indentation, etc.

Q7. Differentiate between Row and Column,
Ans. Differences berween Row and Column are:

Ruw Column

The harizontal Unes in | The vertical Unes In
warksheet are called worksheet are called
rOWS. columns.

Row headings are
represented by
numbers Uke 1, 2. 3, etc.

Column headings
are shown by Capital
Alphabet Uke A. B, C, etc.

Q 8. Write the cell address of the following
() First row and first column ...........
(i1) First column and Last row ............

(iii) First row and last column ...........
(iv) Last column and first row........

ucnvone €

Ans. (I) Al (i) A1D4B8576
(ifi) AMJT (iv) AMJT

Q 9. Identify the following range of cells as Row range,
Column range, Row and Column range.

(i) Al:A7 (ii) AL : D1
(iii) A3 :D7 (iv) B4 : B12
Ans. (i) Al: A7 ————- Column Range
(i) A1: Dl ===~~~ Row Range
(i) A3: D7 - - —-- Row and Column Range

(iv)B4:B12 - -~~~ Column Range

Q 10. Evaluate the following equations using operator
precedence and then test the result in the

spreadsheet.
(i) 1+272-2 (ii) 4°3/2

Ans. () 3 () &

Q 1L Write the steps to Insert a column bofore any
column.

Ans. To insert a column before any column, poslition the
cursar an any cell of the column befare which you
want to Insert the column and select

Sheet — Insert Columns — Columngs — Columins left

Q 12. Write the output of the following an the basls of
the given screenshot.

il] Untitled 1 - LibraOffico Calc O X

Fle [dit  \ew [noert  Fgraast Sgdos §hoat

‘B D& QI X 3 G A 24
 Fllow ¥ B I U - 5

I-.‘”‘.D_“" Iv[ Se 5o =5 v |

Qo Jools B X

LLEHmmmm Sans

5

< d
W 4 b ) + Shoall Shaot? Shootd ‘ @

SimulJuI] Duim.m English {Indin) | HT @ | = smmvsrsini{femesesssiiincim

(i) =COUNT(AL1:A4)
(i) =COUNT(A1:C1,B2)
(iii) =COUNT(B1:C3)
(lv) =COUNT(A1:A3,C1:C3)
Ans. (I) 3 (i) 4
(iii) & (lv) &
Q 13. Write the steps to format a cell to the required
number of decimal places.
Ans. The steps to format a cell to the required number of
decimal places are;

(i) Select the range of cells

(i) Open the ‘format cells dialog' box
(iif) Click the '"Number' tab

(iv) Select the 'Number’
(
(

v) Change the decimal places as required
vi) Click 'OK’
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Q14.
Ans.

Q15.

Ans.

Q6.

Write the steps to format a range of cells as text.
Steps to format a range of cells as text:

(i) Select the range of cells

(I} Open the format cells dlalog’ box

(lli) Clck the Number tab

(iv) Select Text

(v) Click 'OK'

(vl) Enter numbers

Aman is writing telephone number along with STD
code (starting from zero '0'). He noticed that the
first digit zero ('0'), disappears from the telephone
number. Write the reason for this. What can be
done to store telephone number starting from
zero in a cell?

This Is because the telephone number Is stored as a
numeric value and the numeric value does not have
a preceding zero. We can store telephone number
starting from zero In a cell by formatting the cell
conslsting of telephane number ag ‘text’

How will you find the lowest score in English and
Maths using functions?

(il
Piw

rn
(il

Elokibiesd T« Uik Cals = l

ol
Baa  Miew  Jrosa Pgenst Stgles Dot Dota Joub  Winodew  Help E

BB DBRIXRDRAE LD

Q 19. What do you mean by absolute referencing in Calc?

Ans. In Absolute referencing, a S symbol is used befare
the column name as well as row number to make It
constant in any formula. Far example, SC512, 5DS5.
etc. In this case, even If you drag your farmula In any
direction, the cell name remains constant.

Q 20. Identifythe types of referencing from the following:
(i) =C1 (ii) =D$2

(iii) =3W2 (iv) =$E$4

Ans.

Q2l.

Ansg,

Q 22
Ans.

(I) Relative Referencing
(i) Mixed Referencing
(iii) Mixed Referencing
(iv) Absolute Referencing
Name any four types of charts that can be created
in OpenOffice Calc.
Four types of Charts are:
(i) Bar Chart (i) Column Chart
(111} Ple Chart (iv) Line Chart
Write the steps to create column chart in Calc.
Steps to create column chart In Cale are:
() Select the range of data.
(i) Click on Insert -» Chart
(i) Select the type of chart
(Ilv) Select the chart (Column Chart)
(v) Click finish.

Litwstlion Qoo ‘-'i tm _| B | U " & - F& » >3
al el S Do m | s v | =
s | «c | o [
STUDENT NAME | HINDI |ENGLISH| MATHS |

3 HARMAN 77 70l I Ay
[ @ JNYAMT T h [ .
FE HIYA i r 1 lu
[ 3 [ AVIRAL nr__ | o ]

G HIIDAY 3] 1 1 (@
7 il
3 d B
Mod b o Shootl TS ool Srawdd

Shoutdold | Dofoud | Gogfih (e | o0l [ - {1 <+ | \DOG

7] Long Answer

N\ Type Questions

Q L. Identify the following components of LibreOffice

Calc Interface.

e 11 TR (1% T TN A ¥

Moy [hds Josh

||.'5,=|.'\.:|.|_I.I. i

Ans. We can find the lowest score In English and Maths

Q.

Ans.

Q 18.
Ans.

by any of the following:

Drag the formula from BS to DS,
OR

Copy paste the formula fram B9 to C9 and D9.
OR

Write formula emin(C2: C6) In C9 and emin(D2 : D6)
in DS.

Explain the Relative referencing In Calc with
example.

When you drag any formula in any row or column
In any direction, the formula gets copled In the new
cell with the relative reference. For example =Cl is
an example of relative referencing, as this formula
changes automatically when we drag it vertically or
harizontally.

What do you mean by mixed referencing in Calc?
In Mixed Referencing. the $ sign Is used before row
number or calumn name to make It constant. For
example = CS1is an example of mixed referencing,
as this formula changes only when you drag It
horizontally.
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EH-D&D X BB b A A% B[ 0 s
YT [l oo [ I e s, @ 2 8 4 K

] o 7 — 1
CAT B TF] -4

=
3 |
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1 o=h Rkead

Ans. Name of Components are:

A - Name Box

B - Vertical Scroll Bar

C - Zoom Control

D - Quick Access Toolbar

E - Status Bar

F - Formula Bar

Answer the questions based on the following
worksheet.

() What is the address of the first cell represented
by Range 1?

i

Qe
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(ii) What is the address of the last cell represented
by Range 1?
(iii) Write the cell range represented by Range 1.

(iv) Min: This function return the smallest value
contalned in a range of cells. For example
=min(Al : A5) will return the smallest value

(iv) Write the cell range represented by Range 2.
(v) What is the name of the cell range along a row?

(vi) What is the name of the cell range along a
column?

(vil) Write the cell range represented by Range 3.

(vilil) Give the number of cells in the cell range
represented by Range 3.

present in cell Al, A2, A3, A4 and AS.

(v) Count: This function counts the number of non-
empty cells within a range of cells. For example
=count(Al: A5) will return 5. if all cells contaln
some any value.

Q 5. Write the output of the following on the basls of
the given screenshot (Any four).

] ik 1= i D Gab - 0 =
fa 08 Maw  ogr Fawes  Bade Bwed i Bob [Boedoe B M Untitled 1 - UbraOiflce Calc e a X
bl ol D@ R X DB 8 & Wl B " fle  Edr  Miew [nsort  Fgemant  SQes  Sheot [uta Yool B X
PR alian hiea |l | B LL e w0 — = - :T 8 a = &y
;lﬂ nEH B I U-A A @B D@ QR X0 B e >
) e | e [=] %_L{bm'.ub'ﬂﬂ SEV]_ R : iil ;_m_iﬂ E] B I u - by
. T | e %;ﬂ.hDd__ E| Iy Z v =|“‘5 i | L
] 1 ii ,*,.,_1 5=—1]
hi— H - ! n. @
: | ® 5 5 7 I
:: - | — ife ll 7 ! i %;;
B | m—rLLCT 5 5 B 7 -
;_”“ | ' 1 0 5 7 r@
._:: | | | 3 5 'Iu-
B | < >
Gonb P e el e — — w4 b b = Shest! Shootz  Shontd @
kool el . 2l Leelsdholbiadioi | o e sl el LA = : — .
P iw = — i e Shogi 3ot 3| Dofault | Engloh (ngtia) | ©F | 60 2o i
w1 ) () =SUM (A1,81,C1)
(i) B5:D5 (iv) F5:FI (i) =SUM(AL:C1)
(v) Range 1 (V) Range 2 (i) =SUM(A1:C1,B2)
(vil) B7:C12 (viil) 12 (iv) =SUM(B1:C2)

Q 3. Evaluate the following equations using operator (v) =SUM(A1:A3,C1:C3)

precedence and then test the result in the Ans. (1) 17 (i 17
spreadsheet (Any 8). (i) 24 (V) 23
(i) 8-4/2 () 5°5+8 (v) 37
(il)) 3+5°4 (iv) 2°5+8
(v) 3+22 (V) 5+6°2°2 Q 6. Write the output of the following on the basls of
(vil) 8/4°4 (vill) -4/2+2 the given screenshot (Any four).
(ix) 1+242-2 (K) 4!3/2 il Uawittod 1 - LituoQffica Cole w0 ] p 4
Ans. U) 6 (“) 33 fite  Bdd Mew  |need Fgomot  Stes  Sheet  Quls Joou w X
(I 23 (v) 40 wm-2D-B- D@ QI XHMHleg »
((;‘;)); ((w; ‘39 Ubaniionsans v o v BT U - »
v vili o - —
(ix) 3 (x) 6 A1 [:“__| Jx & =|_5 |"_J -
Q 4. Explain the following functions with examples: 3 5 / ,; ot =]
(I) sum (ll) average 8 / L / A
(iil) max (iv) min 3 2 2 !
(v) count 5 | oM
Ans. (i) Sum: This function adds the values contalned In (54 Ly Dl Sl Enl sta >l l G)
a range of cells. Far example = sum(A1: A5) will Shonibol2] Dot Bgln a0l BT 81 | = :
add all the values of cell Al, A2, A3, A4 and AS. () =AVERAGE (ALB1,C1)
() Average: This function finds out the average (ii) =AVERAGE (Al:Cl]ll
of the values contalned in a range of cell For _
example =average(Al: A5) will return the average (1 SAVERAGEALIEL,B)
of values present In cell Al. A2, A3, A4 and A5. () fAVERAGE [BifCZ} )
(iii) Max: This function return the largest value {v) WERAEE s .
contained in a range of cells. For example Ans. (i) 5.66 (i) 5.66
=max(Al ; A5) will return the largest value (lli) 6.33 (lv) 5.75
present in cell Al. A2, A3. A4 and AS. (v) 616
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Q7. Write answers for the following queries using

functions (Any four).

1 = LR tvtiey Crlg — ] b4

|:|.] Liafibiet

(i) Write the formula in E2 to find the total marks
scored by HARMAN.

(ii)) Write the formula in F2 to find the average

| marks scored by HARMAN.
Flp  Fefit Mow  Insart  Fooeat  Sffe §hett Pava Tooln MWindow pdp X (”i) Write the formula In cell B7 to find the hlghggt
=] : | ! i [n L F L w 7]
= -5 D’ = @'_ BB &0 scare in Hindi.
waoionsans vl jept ol BT U+ 4 - -] 3 (iv) Write the formula in cell BB to find the total
mo V| Ji Low =] sruoma e = number of students who appeared in Hindi?
n-_ 8| ¢ | o | [F (v) Write the formula in cell B9 to find the lowest
STUDENT NAME | HINDI |ENGLISH| MATHS .
2 HARMAN 77 76 s | A gcore In Hindl.
3 JAYANT 7l 75 5]
i YA 75 07 7 o Ang. () =sum(B2:D2)
5 AVIRAL 07 60 76 - :
2 ni it o = _ © (Il) =average(B2:D2)
1 | | i (i) =max(B2: B6)
& b b o Swoil  Shoo®  Shootd  Shosd | Jx (iv) =count(B2 : B6)
[ Shootdald | Defsall Enphah (lndia) | @] 0 > ' + | tom (‘u")' :mtn(BZ . 86)
Q 8. Create the following worksheet in calc and write the formula for the task glven below (Any four).
il Untitled 1 - LibreOffice Calc - O X
Eile Edit View |[nsert Format Styles §heet Pata  Jools Window  Help X
w-E2-B- DR X0DE-14 49O Q2% 8- »
Liberation Sans vll1opt M| B I U -_Aff@ v ;—|?|m—; _¢ -é fl_ )
G2 vil fy 2i == | » =
1 NAME MATHS [SCIENCE |ENGLISH |HISTORY |SANSKRIT| TOTAL
HARMAN 86 84 57 71 82 1 A/
3 ANKUR 89 79 84 78 85
4 DIKSHA 52 56 69 84 59 |
5 MANISH 40 86 36 74 69
6 HARSHITA 89 43 42 63 76 (o)
i SHEETAL 52 85 40 34 57
8 JYOTSANA 84 65 71 838 81 f}{
g W
< > i
4 4 » bl == Sheetl  Sheetz  Sheet3  Sheet4  Sheet5
Sheet 5 of 5 | Defoult | English (India) | o] @ | - —e 4 | 100%
(I) Enter the formula In G2 to calculate the total marks scored by Harman.
(i) Enter the formula in H2 to calculate the average scored by Harman.
(1ll) Enter the formula in B9 to find out the highest score obtained for sclence.
(iv) Enter the formula in B10 to find out the lowest score obtained by students in each subject.
(v) Enter the formula In B11 to find out the number of students present for each subject.
(vi) Enter the formula in B12 to find out the average score of each subject.
Ans. (I) =sum(B2:F2)
() =average(B2:F2)
(i) =max(C2:C8)
(lv) Write formula =min(B2 : B8) In B10 and then drag harizontally till F10.
(v) Write formula =count(B2 : B8) In B11 and then drag horlzontally till F11.
(vi) Write formula =average(B2 : B8) in B12 and then drag horizontally till F12
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Q 9. Create the following worksheet in calc and write the formula for the task given below (Any eight).

| Untitled 1 - LibsaOffice Cale O X

Fide [Edit Yiew [nsart  Fgrnat  Stykes  Sheet [ota Tooh  Window  Help X
i ] [ ; e ; n [ = 1 e Y fal Z ]
B-B-B-D@QI X B B2 49-C % BE-BH-EA2Y »

Liberation Sons e B8l I U-JA-B-EE==2Fs2 s BEHEB »

Al v Lo =[sno. - - - |v‘ =

B C D E F G H ~ =
S. NO. NAME BASIC SALARY | TA(6%96) | DA(14%) | HRA(10%) | CPF(3%) |GROSS SALARY

2 1 AMIT SHARMA 12000 ] A
3 2 DEEPAK GAUTAM 9000

4 3 |CHETNA AGARV/AL 15000 o
5 4 FIROZ KHAN 8500

6 5 GAGAN TOMAR 15600 8 @
7 6 MEENA KUMARI 9800 _

B 7 MIKKI KHANNA 16500 IR
9 B TEJPAL SINGH 14600 i X
10 0 VINAY KUMAR 14600

11 10 YUSUF PATHAN 12600

12 Z | b

< > |

@ 4 b M o= Sheet]  Shoot2  Shootd  Shootd  SheotS ShootG Sheat?

Sheet 70l 7 | Defowlt |  Engthh (Indin) | of| @ Avarsge: | Sum 0 | - { + | 1003

() Write formula in D5 to calculate TA of Firoz Khan.
(il) Write formula in E3 to calculate DA of Deepak Gautam.
(iii) Write formula in FB to calculate HRA of Nikki Khanna.
(iv) Write formula in G7 to calculate CPF of Meena Kumari.
(v) Write formula in C12 to display the highest Baslc salary.
Ans. () = 6/100 ° C5 (I) =14100° C3
(Ill) =10/100 * CB (lv) = 3/100 ° C7
(v) = max (C2:C1)
Q 10. Create the following worksheet in calc and write the formula for the task given below (Any four).

nj) Untitled 1 - LibreOffice Colc O X

File Edit Miew Insert  Fgrmot  Styles  gheat  Dota  Jools  Window Help X

B-B-EB- D@l XBR449-C Q% H-ME-IME

Liberation Sans Vg FlIB| I UYWAB . SIS = |F &+ 2|5 |

AT v fx & = =[sno, B = m
B C D 3 F G g

S.NO. NAME HINDI |[ENGLISH |SCIENCE| MATHS | BIOLOGY

2 1 AMIT 65 84 33 30 69 A

3 2 DEEPAK 31 41 87 57 35 -

4 3 CHETNA 77 48 72 35 65 r@

5 4 FIROZ 76 79 33 73 76

6 B GAGAN 41 93 62 87/ 28 | @

7 6 MEENA 90 g4 92 43 54

S 7 NIKKI 30 90 39 44 59 fx

9 8 TEJPAL 93 74 42 84 48 .

10 9 VINAY 62 81 74 93 86

1 10 YUSUF 27 27 28 61 48 :

12 J' v

la)
N
=

4 4 b Pl == Sheetl Sheet?2 Sheet3 Sheetd Sheet5 Sheetb

Sheet 6 of 6| Dedoult | Englith (India) | ol @] | Average: ; Sums 0 = + | 1005

=
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(i) Write formula in H2 to calculate total marks of Amit.
(ii) Write formula in C12 to calculate minimum marks in Hindi.
(iii)) Write formula in H6 to display lowest marks of Gagan.
(iv) Write the cell range which has marks of Nikki (of all subjects).
(v) Write formula in H7 to calculate percentage of Meena.(Assume all marks are out of 100)
Ans. (I) = sum (C2:G2) (i) = min (C2:CN)
(ill) = min (C6: GB) (lv) Cell range Is CB : G8
(v) = sum (C7 : G7)/500 ° 100
Q 11. Create the following worksheet in calc and write the formula for the task given below (Any four).

i} Untitled 1 - LibreOffice Calc O X
Eile Edit Niew |nsert Fgrmot  Styles  gheet Rota  Tools Window Help X

D * < i ~ i
D-E-B-0& R X8 Bs 4590 & BB BR »
:Libemtinn Sang ?] 5:12 pt H: B3 I u - ﬁ v f'@ v EE % _:—:t _ ? éf— é_ E by
AT vl fx X = =[sno |

B C D : F G "“:“i
S.NO. NAME HINDI |ENGLISH |SCIENCE| MATHS | BIOLOGY

2 1 AMIT 65 84 33 30 69 = A/
3 2 DEEPAK 31 41 87 57 35

4 3 CHETNA 77 48 72 35 65 _nm
5 4 FIROZ 76 79 3 73 76 |

6 5 GAGAN 41 03 52 87 20 @)
7 6 MEENA 00 84 92 43 54

7 NIKKI 20 00 30 a4 59 o
9 8 TEJPAL 93 74 42 84 48

10 ) VINAY 62 81 74 03 86

1 10 YUSUF 27 27 28 61 48 __

12 . | i b8
< > |

4 4 b bl ==  Sheetl Sheet2 Sheot3 Shootd Sheots Shoot6

Shoot 6 0f 6 | Detoult | Englith (India) | oI @ | Averogor ; Sune 0 | - e e +  100%

(1) Write formula in B12 to calculate total number of students.
() Write formula in H9 to calculate the 10% of total marks of Te)pal.
(111) Write formula in 112 to calculate average marks of Sclence subject.
(iv) Write formula in H2 to calculate total marks of subject English, Maths and Blology of Amit.
(v) Write formula in H4 to calculate the average of best three marks of Chetna.
Ans. () = count (B2 : B11) (I) =(C9+ D9+ EI+FY+(EI)° 10100
() = average (E2: EN) (V)= D2 +F2 + G2
(v) = average(C4 + D4 + G4)
Q 12. Create the following worksheet in calc and write the formula for the task glven below (Any Eight).

| Untitlod 1 - LibieOtfice Cale O X
Fite  [dia  Moew oot Fgrosl  Syles fhest [Puls Jools B X
- &
m--B- D& R XHER2 5 »
[Ubamsion Sons *-’J :12 pt 'i B I U~ A -
Al _EJ}:E'=:'5.N{}. |v' =
B c D |'mn!.:: @
S.NO. |ITEMNAME | PRICE QTY
el 1 PENCIL 4 20 Ay
3 2 HUBBER ) 10 =
d 3 COPY 25 30 o=
5 4 BOOK 150 i
G 5 BOARD 45 15 @
I 5 . v
¢ > | f}(
1 ¢ p M <4 Sheotl Shect2  Sheetd Sheold S |
Choat 2 nl 7 Medanilr | Faalich [asa cal {3 — il 4=
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(i) Write formula in E2 to calculate the Total price (Quantity * Price) of Pencil.
(ii) Write formula in C7 to calculate total of Price values.
(i) Write formula in D7 to calculate maximum value of column 'QTY",
(lv) Write formula in CB to calculate average of Price values.
(v) Write formula in C9 to find lowest value of column ‘PRICE.
(vi) =C4° D4 will return ... .
(vii) Write the cell range of all the numerical values of column 'QTY",
(viii) Write the cell address which stores largest/maximum value of column 'PRICE.

(ix) How many values are stored in range C2 : D67
Ans. (i) =C2°D2
(iv) = average (C2: C6)

(vil) D2 : D6 (viil) C5

(i) =sum (C2: C6)
(v) =min (C2:C6)

(iii) = max (D2 : D6)
(vl) 750
(Ix) 10

CHAPTER TEST

Multiple Choice Questions

Q 1. Rename sheet optlon is available In.....c..coeccommmsnonsces

menu,
a. Flle b. EdIt
c. Farmat d. Sheet

Q 2. Extenslon of LIbreOffice Calc file IS .......ccceniunsnmvcncnrsane
a. .o0ds b. xls
C. .0dx d. None of these

Q3. To insert the column before any column select

lllllllllllllllllllllllllll

b. Sheet — Insert Columns — Columns right
C. Sheet — Insert Columns — Columns
d. None of the above
Q 4. Evaluate the following expression, if cell A1, B1 and
C1 has values 10, 20 and 30 respectively.

Al "Bl ~C1
a. 170 b. 100
c. =170 d. None of these

Q 5. Evaluate the following expresslon, if cell A1, B2,C2
and D3 has values 10, 2, 3, 36.
=(D3/(A1+B2))"C2
a. b4 b. 216
6 &7 d. 125
VB o Is the function in LibreOffice Calc to
get the sum of range of cells.
a. ADD() b. SUM()
c. Both a. and b. d. None of these
Q7. Which of the following will return the sum of Cell Al
to E1.
a. =SUM(A1: E1)
b. =(A1+B1+ Cl+ D1+ El)
c. =SUM(A1B1.C1.D1.EY)
d. All of these
Q 8. Which of the following function calculate the
average In LibreOffice Calc?
a. AVG()
b. AVERAGE( )
c. Both a. and b.

A None of these
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Fill in the Blanks

Q9. Numbers entered into a cell are automatically
........................... aligned.
Q 10. IfA1:AS contain the numbers 16,10, 3,25 and 6 then
= Avarage(AL1:A5;60) will display ...cccumicccinmni, :

Q1L In refarencing, the reference
changes rows and columns automatically when It Is

---------------------------

copled to a new cell.

Assertion-Reason Type Questions

Directlons (Q, Nos. 12-13): In the questions glven

below, there are two statements marked as Assertion

(A) and Reason (R). Read the statements and choose the

correct option.

a. Both Assertion (A) and Reason (R) are true and
Reason (R) Is the correct explanation of Assertion (A).

b. Both Assertion (A) and Reason (R) are true. but
Reason (R) ts not correct explanation of Assertion (A).

c. Assertlon (A) Is true, but Reasan (R) Is false.

d. Assertion (A) Is false, but Reason (R) Is true.

Q 12. Assertion (A): Spreadsheet software is utilised for
manipulation of data and creation of workbook
files comprising one/more related worksheats.
Reason (R): Cell Reference Is used for identifying a
cell or a range of cells, in a worksheet. References
help to look for the values which are to be used Iin
a formula in different parts of a worksheet.

Assertlon (A):
out calculations that involve basic arithmetic
addition,

Q18. Functions are used to carry

operations such as multiplication,

subtraction and division.
Reason (R): The Title bar displays the sheet

information as well as the insertion nnint loncatinn_
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Case Study Based Questions

Q14. The Spreadsheet Operators perform actions on

numeric values, text or cell references. There are
four different types of Spreadsheet Operators.
These are: Arithmetic Operators, Text Operator,
Comparison Operators and Reference Operators.
To perform basic mathematical operations
such as addition, subtraction, or multiplication,
combine numbers or produce numeric results,
use¢ the arithmetic operators. The Comparison
Operators are used when defining conditions.
The Reference Operators are used when referring
to ranges within a spreadsheet.
A formula s an expression that operates on values
in 0 range of cells or a cell. Functions are pre-
defined formulas in spreadsheet. They eliminato
laborious manual entry of formulas while giving
them human-friendly names.

() Which operator in the glven expression has the

highest priority?
©w5+6°2"2
a. b. -
g ® d. None of these
(I) Which of the following operator has the highest
priority?
a. () b. * C.’ d. +

If we forgot to put the '=' before the formula, It
Will be treated as @ ....cccisnrercccorsaseens

b. Function

(i)

a. Value
c. Label d. None of these

(iv) When we enter an equal sign ('=') In any
GakL: SN icaissmisising bar gets actlvated
automatically.
a. Formula b. Formatting
c. Menu d. None of these

(v) Which of the following Is a valld way of writing
formula?
8. F2 o B] + (] b. @Bl + (]

c. Both a. and b. d. None of these

Q15. Calc is a spreadsheet program used to record

and analyse numerical and statistical data,
LibreOffice Calc provides multiple features to
perform various operations like calculations,
pivot tables, graph tools, macro programming,
etc. It Is compatible with multiple OS like
Windows, macOS, Android and iOS.
A Calc spreadsheet can be understood as a
collection of columns and rows that form a
table. Alphabetical letters are usually assigned
to columns and numbers are usually assigned Lo
rows. The point where a column and a row meet
is called a cell. The address of a cell is given by
the letter representing the column and the number
representing a row,
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(i) What do you mean by LibreOffice Calc?
(i) What is the use of ODD() function?
(ili) What Is the purpose of the Quick Access toolbar
in Calc?
(iv) What is the use of IF function?
(v) What are Arguments?

Very Short Answer Type Questions

Q 16. What do you mean by Function in Calc?

Q 17. Write the shortcut to open Format cell dialog box.
Q 18. What is fill handle in Calc?

Q 19. Write the shortcut for the following:

1. Copy the formula

2. Paste the formula

What do you mean by Referencing in Calc?

Name the three types of referencing in Calc.

Q 20.
Q2L

Short Answer Type Questions

Q 22. How will you find the highest score In Hindl, English

and Maths?
'.!"_t LIl 1o Ll B g e El
flo  [dy Shew oot Fprmot  Siides Sheet Dol Jooht  Mindon  Hdp %
8 - T 3. a
w--B 0B8RI XD EE SHID
__L_ﬁ_nmﬁiun S0 E :"1.'! il v| B | U - & w108 ol
Al v S I o= =] stuoint e w | w
0 c 0 |.1:.'.|~! F
STUDENT NARME HINDI |ENGLISH| MATHS | ==
2 HARMAN T 70 65 A
| ] JAYANT 7o b [ =
4 RIY A i 07 14 (=]
= AVIRAL o7 (0 70
[ 0 HRIDAY 0 14 71 @)
1 ' =
€ > fk
od B bl o Thausl Sl filvound Shocad
Shasad ol 4 | Defowd | Dogbun Onaiw | 071 - 4 + | oo

Q 23. Name and explain the three types of data that can
be entered in a cell.

Q 24. Create the following worksheet In calc and write the
formula for the task glven below.

il Usvittad 1 - LibraOfMse Cale — | %
fie Edit Yow [nsert Fgrmot  Stdes  Sheet Doln  Joobs » X
= S & . O 5 &
B D& Q@ X8R 2 A »
Libauion Sans ?J 512 pt q B [ U~ .& v
Al o _a [y v =| 5. NO. 4 | il
B & D “:”

.i S.NO. |[ITEMNAME | PRICE QTY

2 1 PENCIL i 20 A
3 2 RUBBER 3 10 ;

4 3 COPY 25 =
S A BOOK 150 i

? b BOARD | 45 16 4 @
< > | x
@ 4 p M 4  Sheetl  Sheet2  Shestd  Sheetd S

Shest 2017 Defoull| English {inciie) | @I @ | | = b +
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(i) =C4° D4 will return ......cceeeveeerevecarennnns (iii) =MAX(A1:C1)
(ii) Write the cell range of all the numerical values of (iv) =MAX(A1,B1:C2)
column ‘QTY". (v) =MIN(A1,B2,C1)

(ili) Write the cell address which stores largest/ (26 Write the output of the following on the basis of the
maximum value of column 'PRICE", given screenshot (Any four).

(iv) How many values are stored in range C2 : D67 il Untittod 1 - LibreOica Cate B 0 %
Long Answer Type Questinns Eile  Edit  Maow  [nsort Fprmot  Styles  Sheot  [ats Joobs » X
: . e S e el =] -
Q 25. Write the output of the following on the basis of the m - Do 3] X% = 2
gi'_.*en screenshot (Any four). éLlhm‘u&innSm: M [op FJIB I U - 5
il Uritled 1 - LisraOlfice Cale O B —— = .
Fie  [dit Miew |nvort Fgovot  Styles  Shoet  Dota Jool b X immd . j*"‘-' Z & _:5— - 7_“! i
— - o) 3 ) e
ﬁ - 5 - @ o Dl @ [(l’l '.'X‘.- EE] |'I é > 5 5 7 Il —
Ubtabon Sans ﬂ E_m p! ."'I B I U~ by, g ; g ; %?
e M Sy Doe = v | = 1 : 2 2 4 i@
E < >
4 4 P Ih + Shoot] Sheat2  Shontd @
%? Shoot 313 Dafault Englith (ndin) | &I | @ | = |
3 | | "Iv; el (i) @ MIN(A2:C2,B3)
< > '
DN b S S S @ (ii) @ MIN(AL:C1)
' ghont B0t | Detautt| Gsglien oo} | ©1 | ) |- g (iii) = MIN(A1,B1:C2)
(i) = MAX(A1,82,C1) (lv) = COUNT(A1,B1)
(i) = MAX(A2:C2,B3) (v) = COUNT(A1:C1)
Q 27. Create the following worksheet in calc and write the formula for the task glven below (Any four).
[} Ustinied 1 - LoD 1lice Cale 0 X
file [dit MNaw  puomt Fgevsl St fheat  [uts Jools Window Halp X
m -0 @ QX @@ f‘%&a FRECEB R "*"T:--"-!TEFE"\LHU »
Ubaraion Sons & [ ElISBY I U - A - TEIIFHLIS EEB o
AL M s Z - =(sno |-| n
i C D E F G H TI =]
S. NO., NAME BASIC SALARY | TA(650) | DA(14%6) | HRA(10%6) [ CPF(3%6) |GROSS SALARY
2 1 AMIT SHARMA 12000 Ay
1 2 DEEPAK GAUTAM 0000 -
a ] CHETNA AGARWAL 15000 B
5 A FIROZ KHAN BE00 |
6 5 GAGAN TOMAR 15600 B ®
7 6 IAEENA KUMAR 9300 i
g 7 NIKKI KHANNA 16500 8 f
9 0 TEJPAL SINGH 14600 L %
10 D VINAY KUMAR 14000
1 10 YUSUF PATHAN 12800
12 | | v
¢ > |l
[ 4 b b == Shoatl Shﬂﬂrz Shectd Shﬁmd Sheats5  Shoall f Shoﬂ?_
Showt 7017 | Dufautt | Gnglish (o) | il @l | Avowgor ; Suwm 0 = i + | 100N

(i) Write formula in 110 to calculate the gross salary of Vinay Kumar.

(ii) Write formula in H12 to calculate the average of Gross Salary of all employees.
(ili) Write formula in B12 to display the total number of employees.
(lv) Write formula in 111 to calculate average of TA, DA and HRA of Yusuf.

(v) Write formula in C13 to calculate the sum of Basic Salary of all employees.
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